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Abstract

Understanding organic chemistry concepts heavily relies on visualization of the
geometry of molecules and spatial arrangement of molecules during mechanisms. 2D
textbook depictions have their limitations in visualizing the three-dimensionality of
organic chemistry. Student learning outcomes could be greatly improved from 3D
visualizations of these topics. This project explores the potential of an emerging
technology, Virtual Reality (VR), being incorporated as a teaching resource for organic
chemistry.

This paper discusses two trials for evaluating the potential of VR as a teaching
resource for organic chemistry in select topics of the Diels-Alder reaction and R/S
configurations and stereoisomers. The Diels-Alder reaction is a fundamental Nobel-
Prize winning reaction taught in Organic Chemistry Il. Experience has proven that
students often struggle to visualize the transition state of this reaction and to predict the
correct organic products, both in terms of regiochemistry and stereochemistry. R/S
configurations and stereoisomers is a topic taught in Organic Chemistry | in which
students often struggle to visualize 3D molecules to correctly assign the configuration of
chirality centers and further determine the relationship between stereoisomers. Hence,
we chose to develop VR organic chemistry learning exercises for these topics, which
might enhance students’ understanding of the reaction compared to traditional teaching
by taking advantage of the immersive and interactive experiences created by VR. This
paper shows that VR tutorials have comparable student learning outcomes to traditional
learning and students enjoyed learning with VR more than in a traditional classroom
setting. The ethnicity or gender identity of the student did not seem to affect student

benefits from the VR experience, which shows the potential of VR as an equitable



teaching resource for organic chemistry. The methodology of VR development is also

discussed in this paper as reference for future novice VR developers.
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Chapter 1 Introduction to Virtual Reality and its Utility in Chemistry Education

1.1 Introduction to Virtual Reality (VR)

Virtual Reality (VR) is an emerging technology that can simulate an immersive
environment within which the user can exist and interact with the simulated objects,
effectively mimicking experiences in reality!. These simulations are often presented to
the users on multiple screens around the user or on a wearable display?. The multiple
screens display provides users a non-immersive VR experience, while a head-mounted
display (HMD), such as the Meta Quest 2, provides users an immersive VR
experience?. In an immersive VR experience, users are presented with a 360-degree
virtual environment around them, and the head and hand movements of the user are
reflected in the virtual environment with the help of movement tracking sensors in the
HMD and the controllers?. As VR developers continue to be innovative and VR consoles
become more accessible to the public, more sectors have been incorporating VR,

notably in gaming, health care, and education?.

@ -

Figure 1.1. Meta Quest 2 Headset (middle) and Controllers (left and right)3.



1.2 Potential of VR in Chemistry Education

While traditional learning is the most abundant teaching method, it has
limitations. One criticism is that learners find traditional methods to be unengaging and
taught content often have variability between instructors due to different emphasis on
topics or pacing of the class®. Reviewing instances where VR was used in education,
Gunawan’s group found that every discipline that has existing knowledge could take
advantage of using VR to teach users new concepts or reinforce concepts?. In
education, the use of VR as a teaching aid has potential to increase participation and
opportunities as well as enhance learning. This is made possible by the fact that VR
mimics real world experiences, so the skills students learn in the VR environment is
transferable to the real world!. VR can further help increase attention levels of students
as the HMD can help in eliminating visual and auditory distractions from the real world?.
Some advantages of VR learning include being engaging through its audiovisual
experience, increasing creative problem-solving skills for the students, and avoiding
potential negative consequences from choices made during the learning process?.
Gunawan’s group also found that many study results seem to support the idea that VR
learning is more effective than traditional learning!. The use of VR especially increased
during the COVID-19 pandemic as a novel method of delivering asynchronous lectures,
and VR was reported to be more engaging to students than watching videos?.

VR learning, however, is not without flaws. One of the limitations of VR learning
is that since VR content has to be developed beforehand, the range of questions that
can be answered within the VR experience is limited to what the developers are able to

predict as the students’ questions?. Therefore, Hamad’s group concluded that VR



cannot replace traditional learning due to its inability to adapt to various real-time
questions posed by the students?. Another limitation of VR is the lack of standardization
of VR often leading to difficulty in transferring applications between different device
types. Moreover, VR development requires decently powerful computers which are not
accessible to all. Finally, the physical strain on the eyes and neck due to the HMDs can
cause “cybersickness”, which is a type of motion sickness induced by VR2.
Cybersickness is most likely due to the slight lag in the HMD’s virtual world display
compared to the real-world movements?.

Despite its limitations, VR is steadily establishing its use in science, technology,
engineering, and mathematics (STEM) education, as it can promote active learning as
opposed to the more often passive traditional learning®. Students can also safely
experience diverse environments in a short time, and even experience environments
that would be impossible to explore in the real world?. VR can also help bypass safety
concerns. For example, in a chemistry lab learning context some students are
inadequately prepared to be in a real-life laboratory with toxic chemicals and potentially
dangerous instruments®. The limitation that the VR content must be developed
beforehand is still an important concern in STEM education. Many experimental results
are unpredictable, so it is implausible to foresee all the possible outcomes of the
experiments in order to develop VR that is comprehensive®.

Viitaharju’s research group delineated the potential advantages and limitations of
using VR as a chemistry laboratory supplement. In this study first-year chemical
engineering students at Aalto University were tasked with virtual laboratories before

their real-life laboratory exercises on flame atomic absorption spectroscopy (AAS) or



UV-Vis spectrophotometry®. Student feedback revealed that while many students
thought the videos of every step of the lab being carried out was interesting, the videos
could become too repetitive and were slow-paced®. On the other hand, students also
reported that the interactive questions in the virtual laboratory were interesting, while the
instructions in PDF format were reported as boring®. Many students agreed that they
thought that the real-life laboratory exercise was easier, and they felt more comfortable
in the real-life laboratory after completing virtual laboratory®. However, most students
also reported that they thought the real-life laboratory was more interesting than the
virtual laboratory®. This suggests that VR has potential as a supplemental learning tool

in chemistry education rather than a replacement®.

1.3 State of the Art

There are numerous instances where VR was used to aid in educating users
about a chemical process, mechanism, or proper protocol in a laboratory setting. Lu’s
group developed the Virtual Reality Remote Education for Experimental Chemistry
system that teaches users how to synthesize gold nanocrystals to address the lack of
resources to remotely continue experimental chemistry education in times such as
COVID-19°. Broyer developed an immersive VR tutorial on glove hygiene in a chemical
laboratory to help first year undergraduate chemistry laboratory students feel more
comfortable about entering their first chemistry laboratory and to promote appropriate
glove use in the laboratory’, and Dr. Emmanuel Echeverri-Jimenez developed a VR
tutorial for the Diels-Alder mechanism in 20228. During the COVID-19 pandemic, many
institutions including the William & Mary Chemistry Department incorporated the Virtual

Reality Organic Chemistry Labs that were previously developed by North Carolina State



into the remote Organic Chemistry | lab. North Carolina State generously offered all of
its developed Organic Chemistry VR laboratory content to other institutions free of
charge, aiding them in navigating the abrupt shift to online learning prompted by the
pandemic?®.

NC State’s VR Organic Chemistry Labs include virtual exercises on various
topics from laboratory techniques and lectures, such as Thin Layer Chromatography
(TLC), Extraction, and SN2 Reactions of Alkyl Halides®. There are two major modes of
delivery for these labs: on a computer or on a mobile device®. On a computer, students
would navigate through the user interface of the tutorials and view the 360-degree
laboratory environment using a mouse or keyboard®. On a mobile device, students
could choose the Google Cardboard option to place their phone into the Google
Cardboard, where they can move their head to view the 360-degree environment, just
like in a Meta Quest headset®. Unfortunately, this option was not available for
investigation as the application used to launch the VR lab was designed for an older
version of Android. In the computer delivery of the 360-degree laboratory environment,
there is a teaching assistant (TA) who guides students through the exercise by reading
aloud the instructions on the user interface, and students can navigate through the
exercise®. While the experiment is performed, students can observe the hands of the TA
in the video performing the steps of the experiment while the directions are read by the
TA as a narration®. While it was helpful to watch and learn how the experiments are
conducted, there are minimal interactable components. Occasionally, buttons can be
pressed to prompt an action or predictions for outcomes can be selected on the user

interface, but students don’t have the opportunity to practice going through the motions



of the experiment themselves. It is important to note that NC State intentionally chose a
diverse group of TAs to be featured in their VR labs in an effort to promote diversity,
equity and inclusion.

We took the NC State’s VR Organic Chemistry Labs as an inspiration and looked
for possible areas of improvement. One potential area of improvement was the use of
adaptive release, where specific material is released based on meeting one or more
criteria. NC State’s VR Organic Chemistry labs were formatted with short, replayable
360 video segments that students could look around in, with occasional questions that
check for understanding®. However, there were no features in the VR labs that
prevented students from skipping to the end of the video clip, or neglecting to answer
the questions that check for understanding. The lack of features that control the release
of subsequent content in an asynchronous environment such as a VR lab has the
potential for exploitation by students as they can complete the exercises without much
understanding or engaging with the material. With the use of adaptive release, we can
control if the subsequent topic should be presented to the user based on whether the
student completes the previous task that is necessary for understanding the next
segment’s topics. We acknowledge that even with adaptive release it is still possible for
students to mindlessly navigate to the end of the tutorial by randomly clicking all the
possible answers, however they would still have to be exposed to the correct answer
and the feedback before they can move on to the next topic.

While developing VR tutorials for this research, we hoped to implement adaptive
release and increase the interactiveness of the VR tutorials compared to NC State’s VR

Organic Chemistry Labs because we wanted to take full advantage of the immersive



and interactive nature of a VR environment. This is by no means a critique of the NC
State’s VR labs; in fact, we view them as a pioneering development that we hope to

build upon.



Chapter 2 - Application in Organic Chemistry 2
2.1 The Diels-Alder Reaction

The Diels-Alder reaction is a cycloaddition between an alkene or an alkyne and a
conjugated diene. The alkene (contains a double bond) or alkyne (contains a triple
bond) is called a dienophile, and a conjugated diene is a molecule with two double
bonds that are separated by exactly one single bond. This reaction is a cycloaddition
because its products are cyclic. The reaction mechanism results in two new ¢ bonds

and one new &t bond forming, and three © bonds breaking, as shown in Scheme 2.1.

Diene Dienophile

A

Scheme 2.1. A Simple Diels-Alder Reaction Mechanism. Two new ¢ bonds and one
new 7 bond are formed and three = bonds are broken.



The stereochemistry of the product depends on the stereochemistry of the
dienophile and the diene. A case where the stereochemistry of the product depends
solely on the stereochemistry of the dienophile is shown in Scheme 2.2. A cis
dienophile results in a syn product, whereas a trans dienophile results in an anti

product.

Diene Dienophile

e
\/‘”

a cis dienophile Y

Syn enantiomers

Scheme 2.2. A Diels-Alder Reaction with Substituted Dienophile.
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A case where the stereochemistry of the product depends solely on the
stereochemistry of the diene is shown in Scheme 2.3. Substituents that pointing toward
the “outside” on the diene (ethyl group in Scheme 2.3) and substituents that are
pointing toward the “inside” of the diene (methyl group in Scheme 2.3) end up anti to
each other in the product. Substituents that are both pointing to the “outside” of the
diene or substituents that are both pointing to the “inside” of the diene end up syn to

each other in the product.

Diene Dienophile
/
A
—_—
X\

Diene with ethyl group "outside"
and methyl group "inside"

Y

anti enantiomers

Scheme 2.3. A Diels-Alder Reaction with Substituted Diene.
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A case where substituents on both the dienophile and the diene contribute to
stereochemistry is shown in Scheme 2.4. This case can lead to endo- and exo-
products, which are diastereomers. In the major endo- products the “outside” groups on
the diene end up in a syn conformation with respect to the electron withdrawing groups
on the dienophile, whereas in the minor exo- products the “outside” groups on the diene
end up in an anti conformation with respect to the to the electron withdrawing groups on
the dienophile. Scheme 2.4 also shows that the Diels-Alder reaction can form bicyclic

products if the diene is cyclic. A bicyclic product would also form if the dienophile were

cyclic.
Diene Dienophile
A
[ —
endo exo
major product minor product
a cyclic diene  a cis dienophile \ /

Y

diastereomers

Scheme 2.4. A Diels-Alder Reaction with Substituents on Dienophile and Diene.
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2.2 Diels-Alder Tutorial

From the Organic Chemistry Il curriculum, we selected the Diels-Alder reaction
for development of a VR tutorial. The products of Diels-Alder are cyclic, which would be
excellent to view with 3D models in VR. In some cases, the Diels-Alder reaction
produces major endo- and minor exo- products, which are diastereomers and would be
great models to compare side-by-side in VR. While designing the VR tutorial, we initially
aimed to include both the stereochemistry and regiochemistry of the Diels-Alder
reaction arising from different starting diene and dienophile reactants, but due to the
limited time we had in developing and the difficulties in estimating the duration of the VR
tutorial, we ended up developing a tutorial that focused primarily on the stereochemistry
of the Diels-Alder reaction.

Features in the Diels-Alder tutorial include presentation of topics on a user
interface (Ul), interactive molecules and chemical reactions, and adaptive release. The
tutorial curriculum was adapted from the contents of Master Organic Chemistry,
summarizing the basic Diels-Alder reaction scheme and how to determine the
stereochemistry of the Diels-Alder products. The layout of the topics was as follows:
introduction of the Diels-Alder reaction with the reaction mechanism, structural
requirements for the diene for a Diels-Alder reaction to occur, and examples of the
Diels-Alder reaction. The examples of the Diels-Alder reaction were presented in
increasing complexity. Initially, the stereochemical outcome of the reaction was solely
dependent on the substituents of the dienophile or only on the substituents of the diene.
However eventually the user is presented with complex examples where the relative

stereochemistry between the diene and the dienophile comes into play and leads to the
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major endo- and the minor exo- products that arise from a reaction of both a substituted
diene and a substituted dienophile.

The interactive feature of combining the reactants to create the product was
included in this tutorial. Students could grab a diene and a dienophile together and bring
them within a certain distance and they would then be presented with the product of the
reaction. We wanted to also implement an undo reaction feature, where students would
be able to perform the Diels-Alder reaction on a slide and click a button on the Ul to
reset the reaction back to its reactants. Unfortunately, we were unable to implement this
feature due to time limitations.

Adaptive release was also implemented, so that students would only be able to
continue in the tutorial after they have interacted with the reactant molecules to make
the product molecule. Although we were able to implement adaptive release on most of
the tutorial, there were instances where students were presented with two reactions to
explore on one slide, for which we were unable to find a method to track if students
actually explored both reactions as intended. Due to the time-consuming development,

the adaptive release was not implemented on this type of reaction slide.

2.3 Diels-Alder Tutorial Data
Participants

Participants were volunteers (N = 24, 79.2% female) from 190 students enrolled
in Professor Dana Lashley’s CHEM 207 - Organic Chemistry Il for Life Sciences
sections in Fall 2023. Trials were advertised as an optional help session, which would

provide an extra opportunity to engage with the Diels-Alder reaction covered in class.
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Various one-hour sessions were available for students to sign up on December 6t"-7t
and students were randomly assigned to either the VR learning group (N = 12) or the
traditional learning group (N = 12).

Measures

We conducted a pre-survey and a post-survey with a questionnaire developed
with Qualtrics. In the pre-survey, we collected demographic data of the students’ major,
race and ethnicity, gender identity, international student status, and neurodiversity
status.

We also measured the comfort level of their understanding of the Diels-Alder
reaction prior to the help session on a scale of 1-7, 1 being extremely uncomfortable
and 7 being extremely comfortable.

In the post-survey, we asked what learning group the student was assigned to
and whether they have prior experience in using VR. We measured their enjoyment
level during the help session on a scale of 1-7, 1 being extremely unenjoyable and 7
being extremely enjoyable. We also measured the comfort level of their understanding
of the Diels-Alder reaction after the help session on a scale of 1-7, 1 being extremely
uncomfortable and 7 being extremely comfortable. Students also answered two multiple
choice questions on predicting the major product of Diels-Alder reactions as part of the
post-survey. Finally, students were presented with one free response question on
predicting the product of a Diels-Alder reaction timed for three minutes to simulate on-

paper exam conditions.
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Procedure

At the beginning of each hour session, the residing investigator (Jungmin Shin)
informed students on the purpose of this study, any health risks associated with the
study, what data would be collected throughout the session, and that the participation in
the study was voluntary. The investigator obtained signatures on the consent form from
students who agreed to the above terms. Students were instructed to the Qualtrics link
to answer the first page of the link to complete the pre-survey questions and set the
survey aside for after the tutorial.

After the pre-survey, students in the VR learning group were administered the
WM Diels-Alder Tutorial 2024 developed with the Unity game engine for the Meta Quest
2 headset. Students in the VR learning group were directed to navigate through the VR
tutorial at their own pace. Students in the traditional learning group were given handouts
with the same content as in the VR tutorial. For the traditional learning group, diagrams
were drawn out on a white board to supplement the verbal explanations of the
investigator and students were asked questions throughout the lecture to check their
understanding of the content being presented and to keep them engaged in the lecture.

After the tutorial, students were directed to return to the Qualtrics link to complete
the post-survey questions and submit the Qualtrics link. For the two multiple choice
guestions embedded into the Qualtrics survey, students were also provided with the
paper version of the questions so that they could see the question better and have the
option of solving the problems with paper and pencil. After the surveys were submitted,
the investigator went over the two multiple choice questions, and students were asked

to complete the 3-minute on-paper exam simulation.
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Data Analytic Plan

Paired samples t-tests were conducted to determine if there was a difference in
comfort levels regarding the Diels-Alder reaction before and after the tutorial for the
combined group of students from both the VR learning and traditional learning groups,
the VR learning group, and the traditional learning group.

Independent samples t-tests were conducted to determine if there was a
difference in enjoyment levels during the Diels-Alder tutorial as well as a difference in
average comfort level score improvement before and after the tutorial between the VR
learning group and the traditional learning group.

Factorial Analysis of Variance (Factorial ANOVA) were conducted to determine if
there was a difference in enjoyment levels during the Diels-Alder tutorial as well as the
difference in magnitude of comfort level changes before and after the tutorial for
students of different ethnic groups or gender identity groups in VR learning group or

traditional learning group.

2.4 Diels-Alder Tutorial Data Analysis

Paired samples t-tests revealed statistically significant differences in the comfort
levels of the combined group of students from both the VR learning and traditional
learning groups. Student reported comfort levels were higher after the tutorial (M =
6.042, SD = 0.624) than comfort levels before the tutorial (M = 5.000, SD = 1.022), t(23)
=-5.108, p <0.05, two tailed test, d = -1.043. Paired samples t-tests also revealed
statistically significant differences in the comfort levels of students in the VR learning

group. The comfort levels of students in the VR group after the tutorial were higher (M =
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6.000, SD = 0.739) than comfort levels before the tutorial (M = 5.000, SD = 0.603), t(11)
=-5.745, p <0.05, two tailed test, d = -1.658. Paired samples t-tests further revealed
statistically significant differences in the comfort levels of students in the traditional
learning group. The comfort levels of students in the traditional learning group after the
tutorial was higher (M = 6.083, SD = 0.515) than comfort levels before the tutorial (M =
5.00, SD =1.348), t(11) = -2.862, p < 0.05, two tailed test, d = -0.826. We concluded
that students in general found the tutorials helped in their understanding of the Diels-
Alder tutorial, regardless of the tutorial mode. We also concluded that the students in
the VR group and traditional learning group found the respective tutorial modes helped

them in understanding the Diels-Alder reaction. Data is summarized in Table 2.1.

Mean Std. Dev. | Mean Std. Dev. Calculated t-
Before Before After After value
Combined Group | 5.000 1.022 6.042 0.624 -5.108*
VR Learning 5.000 0.603 6.000 0.739 -5.745*
Group
Traditional 5.000 1.348 6.083 0.515 -2.862*
Learning Group

Table 2.1. Comfort Levels Before and After the Diels-Alder Tutorial. Statistically

significant t-values are noted with *, a = 0.05.

Independent samples t-tests revealed statistically significant differences in the

reported enjoyment level during the tutorial between the VR learning group or the

traditional learning group. Students in the VR group reported higher enjoyment levels

during the tutorial (M = 6.083, SD = 1.165) than students in the traditional learning

group (M =4.333, SD = 1.435), t(22) = -3.280, p < 0.05, two-tailed test, d = -1.339.

Independent samples t-test revealed no statistically significant differences in the

average comfort level score improvement before and after the tutorial between the VR

learning group and the traditional learning group. There was no difference in the
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average comfort level score improvement between before and after the tutorial for
students in the VR learning group (M = 1.000, SD = 0.603) than students in the
traditional learning group (M = 1.083, SD = 1.311), t(22) = 0.200, p > 0.05, two-tailed
test. We concluded that in general, the students in the VR learning group reported that
they enjoyed the tutorial more than the students in the traditional learning group. We
were unable to conclude if there were any differences between the VR learning group
and the traditional learning group in how much comfort levels increased before and after

the tutorial. Data is summarized in Table 2.2.

VR Mean VR Std. Dev. | Traditional | Traditional Calculated

Mean Std. Dev. t-value
Enjoyment 6.083 1.165 4.333 1.435 -3.280*
Average 1.000 0.603 1.083 1.311 0.200
Comfort
Level
Improvement

Table 2.2. Enjoyment and Average Comfort Level Improvement in Diels-Alder.
Factorial ANOVA revealed a statistically significant difference in the enjoyment
levels during the tutorial for students in different learning groups, but no significant
difference for students of different ethnicities. The 2x3 ANOVA revealed no significant
main effects of ethnicity [F(2, 18) = 0.164, p > 0.05], but a significant main effect of
learning group [F(1, 18) = 4.655, p < 0.05], but no significant interaction [F(2, 18) =

0.391, p > 0.05]. Data is summarized in Table 2.3.

Ethnicity
Learning Group European Non-European | Mixed Ethnicity | Row Means
White White
Traditional 4.125 5.000 4.000 4.375
VR 6.250 6.000 6.000 6.083*
Column Means | 5.188 5.500 5.000

Table 2.3. Enjoyment Levels in Diels-Alder by Ethnicity and Learning Group.
Statistically significant differences in mean are noted with *, a = 0.05.
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Factorial ANOVA also revealed no significant difference in the improvement of

comfort levels after the tutorial for students of different ethnicities experiencing either

tutorial mode. The 2x3 ANOVA revealed no significant main effect of ethnicity [F(2, 18)

=0.301, p > 0.05], no significant main effect of learning group [F(1, 18) = 0.086, p >

0.05], and no significant interaction [F(2, 18) = 0.301, p > 0.05]. Data is summarized in

Table 2.4.
Ethnicity
Learning Group European Non-European | Mixed Ethnicity | Row Means
White White
Traditional 1.125 1.333 0.000 0.819
VR 1.000 1.000 1.000 1.000
Column Means | 1.063 1.167 0.500

Table 2.4. Average Comfort Improvement in Diels-Alder by Ethnicity and Learning
Group. Statistically significant differences in mean are noted with *, a = 0.05.

Factorial ANOVA also revealed no significant difference in enjoyment levels
during the tutorial for students of different gender experiencing either tutorial mode. The
2x3 ANOVA revealed no significant main effect of gender [F(2, 19) = 0.086, p > 0.05],
no significant main effect of learning group [F(1, 19) = 2.701, p > 0.05], and no

significant interaction [F(1, 19) = 0.961, p > 0.05]. Data is summarized in Table 2.5.

Gender ldentity
Learning Group Female Male Prefer notto | Row Means
answer
Traditional 4.222 5.000 4.000 4.407
VR 6.200 5.500 Not Observed | 5.850
Column Means |5.211 5.250 4.000

Table 2.5. Enjoyment Levels in Diels-Alder by Gender and Learning Group. Statistically
significant differences in mean are noted with *, a = 0.05.
Factorial ANOVA also revealed no significant difference in the improvement of

comfort levels after the tutorial for students of different genders experiencing either

tutorial mode. The 2x3 ANOVA revealed no significant main effect of gender [F(2, 19) =
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0.266, p > 0.05], no significant main effect of learning group [F(1, 19) = 0.470, p > 0.05],

and no significant interaction [F(1, 19) = 1.107, p > 0.05]. Data is summarized in Table

2.6.
Gender Identity
Learning Group Female Male Prefer notto | Row Means
answer
Traditional 0.889 1.500 2.000 1.463
VR 1.100 0.500 Not Observed | 0.800
Column Means | 0.994 1.000 2.000

Table 2.6. Average Comfort Improvement in Diels-Alder by Gender and Learning
Group. Statistically significant differences in mean are noted with *, a = 0.05

We concluded that the ethnicity or gender of the student seems to not have an
effect on how much the students enjoy VR or traditional learning nor does ethnicity or
gender have an effect on how much more comfortable they feel about the content after
VR or traditional instruction.

Content Performance

We also kept records of content performance with the check for understanding
guestions and the on-paper exam simulations. Check for understanding question 1
(Scheme 2.5) had an overall correct response rate of 0.958 (23/24), the VR learning
group had a correct response rate of 0.917 (11/12), and the traditional learning group

had a correct response rate of 1.000 (12/12).



Q1. Predict the major product of the following reaction (Choose one):
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Scheme 2.5. Multiple-Choice Check for Understanding Question 1 for Diels-Alder.

Choice 2 is the correct answer.
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Check for understanding question 2 (Scheme 2.6) had an overall correct
response rate of 0.875 (21/24), the VR learning group had a correct response rate of
0.750 (9/12), and the traditional learning group had a correct response rate of 1.000

(12/12).
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22 Predict the major product of the following reaction ({Choose one):
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Scheme 2.6. Multiple-Choice Check for Understanding Question 2 for Diels-Alder.
Choice 5 is the correct answer.
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The on-paper exam simulation (Scheme 2.7) had an overall correct response
rate of 0.458 (11/24), the VR learning group had a correct response rate of 0.500 (6/12),
and the traditional learning group had a correct response rate of 0.417 (5/12). We were
unable to conclude if VR learning had better learning outcomes than traditional
learning.

Predict the product of the following reaction:

Br
7 r
i/ﬂhﬂe

Group (Circle one): VR or Traditional Classroom

Scheme 2.7. Free-Response On-Paper Exam Simulation Question for Diels-Alder.

Data on content performance for Diels-Alder is summarized in Table 2.7.

Overall VR Traditional
Question 1 0.958 0.917 1.000
Question 2 0.875 0.750 1.000
Exam Simulation 0.458 0.500 0.417

Table 2.7. Correct Response Rates for Content Performance in Diels-Alder.

2.5 Possible Sources of Error for Diels-Alder Tutorial

Data collection was conducted from December 6™-7, 2023, which was after the
Diels-Alder reaction was formally tested on an exam, and the final exam for the course
was less than a week away. It is possible that student performances on the check for

understanding questions did not have a statistically significant difference between the
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VR learning group and traditional learning group because the Diels-Alder reaction was
fresh in the students’ minds and students could have been regularly reviewing the
reaction in preparation for the final exam to adequately answer the questions. It is also
possible that the questions were too easy, as the multiple-choice questions had 8
possible choices, some of which were chemically nonsensical and could be easily
eliminated as a possible answer. It is also possible that the content questions were
administered too soon after the tutorials to adequately measure if the students were

better able to internalize the Diels-Alder reaction and retain the content over time.
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Chapter 3 - Application in Organic Chemistry 1
3.1 R/S Configurations and Stereoisomers Background

Molecules that are non-superimposable mirror images with respect to one
another are called enantiomers. Molecules that exhibit biological properties by binding
to a receptor are called “biologically active” and are often of interest in drug
development. The biological properties of two enantiomers can be drastically different.
Often, only one of the enantiomers is biologically active while the other enantiomer is
not active. This also applies to natural products, which are molecules produced by living
organisms. For examples amino acids for the most part only exists in the so called L-
enantiomer form and naturally occurring carbohydrates only exist in the so called D-
enantiomer form (Biochemists use D vs L which is a similar system to the Rvs S
system that organic chemists use). This shows that it is important for chemists to be
able to correctly assign configurations to chirality centers to distinguish these molecules.
In the Organic Chemistry | course, a chirality center is generally defined as a carbon
that is attached to four distinct groups. These four groups are ranked from highest to
lowest priority according to the Cahn-Ingold-Prelog (CIP) convention. According to the
CIP convention, the higher priority groups would be ones that are immediately attached
to the higher atomic number atom. In the case of ties, the first point of difference in the
subsequent set of attached atoms would be considered to assign priority. Once the
priorities are assigned to groups, the molecule is oriented such that the lowest priority
group is pointing away in space and the direction tracing through the first, second, then

third priority groups determine the configuration of the chirality center. A clockwise



27

direction means R-configuration whereas a counterclockwise direction means S-
configuration.

Isomers refer to different compounds with the same molecular formula.
Stereoisomers are a subclass of isomers that have the same connectivity but have
different spatial arrangement of atoms. In the tutorial, three classes of stereoisomers
were discussed: enantiomers, diastereomers, and meso compounds. Enantiomers are a
pair of sterecisomers that are non-superimposable, mirror images. Diastereomers are a
pair of stereocisomers that are non-superimposable, non-mirror images. Meso
compounds are achiral molecules that contain chirality centers. One method of
determining the relationships between a pair of stereoisomers is to assign R/S on each
of the chirality centers and comparing respective chirality centers to see if the
configurations are retained or inverted. If the configuration of every chirality center was
inverted in a stereocisomer with no symmetry, the resulting stereoisomer would be an
enantiomer. If a molecule has chirality centers but also has symmetry, it is a meso
compound. If the configuration of some, but not all, chirality centers were inverted in a

stereoisomer, the resulting stereoisomer would be a diastereomer.

3.2 R/S Configurations and Stereoisomers Application in VR

From the Organic Chemistry | curriculum, we selected the topic of determining
the configurations of chirality centers and determining relationships between
stereoisomers as suitable for the development of a VR tutorial. Since stereocisomers are

isomers with the same connectivity and different spatial arrangement of atoms in 3D
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space, this topic would best utilize the interactive and immersive experience with the 3D
molecules provided in VR.

Similarly to the Diels-Alder Tutorial, features in the R/S Configurations and
Stereoisomers tutorial include presentation of topics on a Ul, interactive molecules,
multiple choice questions to check for understanding, and adaptive release. The tutorial
curriculum was developed based on my past three years of experience tutoring organic
chemistry and some explanations were taken from Professor Lashley’s lecture notes
with her permission to minimize confusion with consistent verbiage between class and
the tutorial content. The layout of the topics was as follows: relevance of
stereochemistry in a biological context, how to identify a chirality center, how to rank
priorities of groups attached to the chirality center following the CIP convention,
assigning configurations to chirality centers, an introduction to stereoisomers, and an in-
depth discussion of enantiomers, diastereomers, and meso-compounds.

Multiple choice questions were integrated throughout the presentation of topics,
checking if students understood the subtopic necessary for the subsequent exercises.
Multiple choice questions were implemented to check if students can identify if a
molecule has chirality centers, assign priority rankings to groups on chirality centers,
assign configurations of chirality centers, and determine relationships between two
molecules.

Adaptive release was also implemented, so that students would only be able to
continue in the tutorial after they have viewed the correct answer to each of the multiple-

choice questions that check for their understanding.
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3.3 R/S Configurations and Stereoisomers Data
Participants

Participants were volunteers (N = 22, 71.4% female) from 114 students enrolled
in Professor Dana Lashley’s CHEM 206 - Organic Chemistry | section in Spring 2024.
Trials were advertised as an optional help session, which would provide an extra
opportunity to engage with determining configurations of chirality centers and
stereoisomers before their midterm exam. Various one-hour sessions were available for
students to sign up between March 18"-24™ students were randomly assigned to either
the VR learning group (N = 11) or the traditional learning group (N = 10). One data point
was omitted because the student did not follow directions and responses were
compromised as a result.

Measures

We conducted a pre-survey and a post-survey with a questionnaire developed
with Qualtrics. In the pre-survey, we collected demographic data of the students’ major,
race and ethnicity, gender identity, international student status, and neurodiversity
status.

We also measured the comfort level of their understanding of determining
configurations of chirality centers and determining relationships between stereoisomers
prior to the help session on a scale of 1-7, 1 being extremely uncomfortable and 7 being
extremely comfortable.

In the post-survey, we asked what learning group the student was assigned and
if they have prior experience in using VR. We measured their enjoyment level during the

help session on a scale of 1-7, 1 being extremely unenjoyable and 7 being extremely
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enjoyable for both topics. We also measured the comfort level of both topics after the
help session on a scale of 1-7, 1 being extremely uncomfortable and 7 being extremely
comfortable. Students also answered two multiple choice questions on determining
relationships between stereoisomers as part of the post-survey. Finally, students were
presented with one multiple choice question on determining relationships between
stereoisomers timed for three minutes to simulate on-paper exam conditions.
Procedure

The procedure for data collection used for the Diels-Alder tutorial data collection
was followed for data collection for the R/S Configurations and Stereoisomers Tutorial.
Data Analytic Plan

Paired samples t-tests were conducted to determine if there was a difference in
the comfort levels regarding determining configuration of chirality centers and
determining relationships between stereoisomers before and after the tutorial for the
combined group of students from both the VR learning and traditional learning groups,
the VR learning group, and the traditional learning group.

Independent samples t-tests were conducted to determine if there was a
difference in enjoyment levels during two topics of the R/S Configurations and
Stereoisomers tutorial as well as a difference in average comfort level score
improvement before and after the tutorial between the VR learning group and the
traditional learning group.

Factorial ANOVA were conducted to determine if there was a difference in
enjoyment levels during learning about both topics for students of different ethnic

groups or gender identity groups in VR learning group or traditional learning group.
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Factorial ANOVA were also conducted to determine if there was a difference in average
comfort level score improvement before and after the tutorial for both topics for students
of different ethnic groups or gender identity groups in VR learning group or traditional

learning group.

3.4 R/S Configurations and Stereoisomers Data Analysis
Subjective Performance in Determining Configuration of Chirality Centers

Paired samples t-tests revealed statistically significant differences in the comfort
levels of students in the combined group of students from both the VR learning and
traditional learning groups. Student reported comfort levels were higher after the tutorial
(M =5.762, SD = 0.769) than comfort levels before the tutorial (M = 4.619, SD = 1.071),
t(20) = -5.754, p < 0.05, two tailed test, d = -1.256. Paired samples t-tests also revealed
statistically significant differences in the comfort levels of students in the VR learning
group. The comfort levels of students in the VR learning group after the tutorial were
higher (M = 5.909, SD = 0.701) than comfort levels before the tutorial (M = 4.727, SD =
1.009), t(10) = -3.634, p < 0.05, two tailed test, d = -1.096. Paired samples t-tests also
revealed statistically significant differences in the comfort levels of students in the
traditional learning group. The comfort levels of students in the traditional learning group
after the tutorial were higher (M = 5.600, SD = 0.843) than comfort levels before the
tutorial (M = 4.500, SD = 1.179), t(9) = -4.714, p < 0.05, two tailed test, d = -1.491. We
concluded that students in general found the tutorial helpful in their understanding of
determining configuration of chirality centers, regardless of tutorial mode. We also

concluded that the students in the VR learning group and traditional learning group
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thought the respective tutorial modes to have helped in their understanding of

determining configuration of chirality centers. Data is summarized in Table 3.1.

Learning Group

Mean Std. Dev. | Mean Std. Dev. | Calculated t-
Before Before After After value
Combined Group | 4.619 1.071 5.762 0.769 -5.754*
VR Learning 4.727 1.009 5.909 0.701 -3.634*
Group
Traditional 4,500 1.179 5.600 0.843 -4.714*

Table 3.1. Comfort Levels Before and After for Determining Configurations. Statistically

significant t-values are noted with *, a = 0.05.
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Independent samples t-tests revealed statistically significant differences in the
reported enjoyment level during this topic of the tutorial between the VR learning group
or the traditional learning group. Students in the VR learning group reported higher
enjoyment levels during this topic of the tutorial (M = 6.000, SD = 0.632) than students
in the traditional learning group (M = 5.000, SD = 1.054), t(19) = -2.666, p < 0.05, two-
tailed test, d = -1.165. Independent samples t-test revealed no statistically significant
differences in the average comfort level score improvement before and after for this
topic of the tutorial between the VR learning group (M = 1.182, SD = 1.078) and the
traditional learning group (M = 1.100, SD = 0.738), t(19) = -0.201, p > 0.05, two-tailed
test. We concluded that in general, students in the VR learning group reported that they
enjoyed learning about determining configuration of chirality centers more than the
students in the traditional learning group. We were unable to conclude if there were any
differences between the different learning groups in how much comfort levels increased
before and after learning about determining configuration of chirality centers. Data is

summarized in Table 3.2.

VR Mean VR Std. Dev. | Traditional | Traditional Calculated
Mean Std. Dev. t-value
Enjoyment 6.000 0.632 5.000 1.054 -2.666*
Average 1.182 1.078 1.100 0.738 -0.201
Comfort
Level
Improvement

Table 3.2. Enjoyment and Average Comfort Improvement for Determining
Configurations. Statistically significant t-values are noted with *, a = 0.05.

Factorial ANOVA revealed no significant difference in the enjoyment levels

during this topic of the tutorial for students of different ethnicities experiencing either

tutorial mode. The 2x3 ANOVA revealed no significant main effect of ethnicity [F(2, 15)
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=0.420, p > 0.05], no significant main effect of learning group [F(1, 15) = 3.439, p >

0.05], and no significant interaction [F(2, 15) = 0.136, p > 0.05]. Data is summarized in

Table 3.3.
Ethnicity
Learning Group European Non-European | Mixed Ethnicity | Row Means
White White
Traditional 5.000 4.750 5.500 5.083
VR 6.167 5.750 6.000 5.972
Column Means | 5.583 5.250 5.750

Table 3.3. Enjoyment Levels in Determining Configurations by Ethnicity and Learning
Group. Statistically significant differences in mean are noted with *, a = 0.05.

Factorial ANOVA also revealed no significant difference in the improvement of
comfort levels after this topic of the tutorial for students of different ethnicities
experiencing either tutorial mode. The 2x3 ANOVA revealed no significant main effect of
ethnicity [F(2, 15) = 0.258, p > 0.05], no significant main effect of learning group [F(1,
15) = 0.069, p > 0.05], and no significant interaction [F(2, 15) = 0.087, p > 0.05]. Data is

summarized in Table 3.4.

Ethnicity
Learning Group European Non-European | Mixed Ethnicity | Row Means
White White
Traditional 1.250 1.250 0.500 1.000
VR 1.167 1.250 1.000 1.139
Column Means | 1.208 1.250 0.750

Table 3.4. Average Comfort Improvement in Determining Configurations by Ethnicity
and Learning Group. Statistically significant differences in mean are noted with *, a =
0.05.

Factorial ANOVA also revealed no significant difference in enjoyment levels

during this topic of the tutorial for students of different genders experiencing either
tutorial mode. The 2x3 ANOVA revealed no significant main effect of gender [F(2, 16) =

0.000, p > 0.05], no significant main effect of learning group [F(1, 16) = 4.151, p > 0.05],
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and no significant interaction [F(1, 16) = 0.000, p > 0.05]. Data is summarized in Table

3.5.

Gender ldentity

Learning Group Female Male Non-binary Row Means
Traditional 5.000 5.000 Not Observed | 5.000

VR 6.000 6.000 6.000 6.000
Column Means | 5.500 5.500 6.000

Table 3.5. Enjoyment Levels in Determining Configurations by Gender and Learning
Group. Statistically significant differences in mean are noted with *, a = 0.05.

Factorial ANOVA also revealed no significant difference in the improvement of

comfort levels after this topic of the tutorial for students of different genders

experiencing either tutorial mode. The 2x3 ANOVA revealed no significant main effect of

gender [F(2, 16) = 0.398, p > 0.05], no significant main effect of learning group [F(1, 16)

= 0.337, p > 0.05], and no significant interaction [F(1, 16) = 1.163, p > 0.05]. Data is

summarized in Table 3.6.

Gender ldentity

Learning Group Female Male Non-binary Row Means
Traditional 1.250 0.500 Not Observed | 0.875

VR 1.000 1.333 2.000 1.444
Column Means | 1.125 0.917 2.000

Table 3.6. Average Comfort Improvement in Determining Configurations by Gender and
Learning Group. Statistically significant differences in mean are noted with *, a = 0.05.

We concluded that the ethnicity or gender of the student seems to not have an

effect on how much the students enjoy VR or traditional learning nor does ethnicity or

gender have an effect on how much more comfortable students feel about the content

after VR or traditional instruction for this topic of the tutorial.
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Subjective Performance in Determining Relationships between Stereoisomers
Paired samples t-tests revealed statistically significant differences in the comfort
levels of students in the overall group. Students reported comfort levels were higher
after the tutorial (M = 4.905, SD = 0.995) than comfort levels before the tutorial (M =
3.476, SD = 1.250), t(20) = -7.071, p < 0.05, two tailed test, d = -1.543. Paired samples
t-tests also revealed statistically significant differences in the comfort levels of students
in the VR learning group. The comfort levels of students in the VR learning group after
the tutorial were higher (M = 4.909, SD = 0.831) than comfort levels before the tutorial
(M =3.273, SD = 0.786), t(10) = -6.708, p < 0.05, two tailed test, d = -2.023. Paired
samples t-tests also revealed statistically significant differences in the comfort levels of
students in the traditional learning group. The comfort levels of students in the
traditional learning group after the tutorial were higher (M = 4.900, SD = 1.197) than
comfort levels before the tutorial (M = 3.700, SD = 1.636), t(9) = -3.674, p < 0.05, two
tailed test, d = -1.162. We concluded that students in general found the tutorial helpful in
their understanding of determining relationships between sterecisomers, regardless of
tutorial mode. We also concluded that the students in the VR learning group and
traditional learning group thought the respective tutorial modes to have helped in their

understanding of determining relationships between stereocisomers. Data is summarized

in Table 3.7.
Mean Std. Dev. Mean Std. Dev. Calculated t-
Before Before After After value
Combined Group 3.476 1.250 4.905 0.995 -7.071*
VR Learning Group | 3.273 0.786 4.909 0.831 -6.708*
Traditional Learning | 3.700 1.636 4.900 1.197 -3.674*
Group

Table 3.7. Comfort Levels Before and After for Stereoisomer Relationships. Statistically

significant t-values are noted with *, a = 0.05.
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Independent samples t-tests revealed no statistically significant differences in the
reported enjoyment level during this topic of the tutorial between the VR learning group
(M =5.636, SD = 0.809) and the traditional learning group (M = 5.200, SD = 1.229),
t(19) = -0.970, p > 0.05, two-tailed test. Independent samples t-test also revealed no
statistically significant differences in the average comfort level score improvement
before and after for this topic of the tutorial between the VR learning group (M = 1.636,
SD = 0.809) and the traditional learning group (M = 1.200, SD = 1.033), t(19) = -1.083,
p > 0.05, two-tailed test. We were unable to conclude if there were any differences
between enjoyment levels between students in different learning groups while learning
about determining relationships between stereoisomers. We were also unable to
conclude if there were any differences between the different learning groups in how
much comfort levels increased before and after learning about determining relationships

of stereoisomers. Data is summarized in Table 3.8.

VR Mean VR Std. Dev. | Traditional | Traditional Calculated
Mean Std. Dev. t-value
Enjoyment 5.636 0.809 5.200 1.229 -0.970
Average 1.636 0.809 1.200 1.033 -1.083
Comfort
Level
Improvement

Table 3.8. Enjoyment and Average Comfort Improvement for Stereoisomer

Relationships. Statistically significant t-values are noted with *, a = 0.05.

Factorial ANOVA revealed no significant difference in the enjoyment levels

during this topic of the tutorial for students of different ethnicities experiencing either

tutorial mode. The 2x3 ANOVA revealed no significant main effect of ethnicity [F(2, 15)

=1.067, p > 0.05], no significant main effect of learning group [F(1, 15) = 0.426, p >
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0.05], and no significant interaction [F(2, 15) = 0.079, p > 0.05]. Data is summarized in

Table 3.9.
Ethnicity
Learning Group European Non-European | Mixed Ethnicity | Row Means
White White
Traditional 5.250 4.750 6.000 5.333
VR 5.833 5.250 6.000 5.694
Column Means | 5.542 5.000 6.000

Table 3.9. Enjoyment Levels in Stereoisomer Relationships by Ethnicity and Learning
Group. Statistically significant differences in mean are noted with *, a = 0.05.

Factorial ANOVA also revealed no significant difference in the improvement of
comfort levels after this topic of the tutorial for students of different ethnicities
experiencing either tutorial mode. The 2x3 ANOVA revealed no significant main effect of
ethnicity [F(2, 15) = 0.707, p > 0.05], no significant main effect of learning group [F(1,
15) = 0.557, p > 0.05], and no significant interaction [F(2, 15) = 0.850, p > 0.05]. Data is

summarized in Table 3.10.

Ethnicity
Learning Group European Non-European | Mixed Ethnicity | Row Means
White White
Traditional 0.750 1.250 2.000 1.333
VR 1.833 1.250 2.000 1.694
Column Means | 1.292 1.250 2.000

Table 3.10. Average Comfort Improvement in Stereoisomer Relationships by Ethnicity
and Learning Group. Statistically significant differences in mean are noted with *, a =

0.05.
Factorial ANOVA also revealed no significant difference in enjoyment levels

during this topic of the tutorial for students of different genders experiencing either
tutorial mode. The 2x3 ANOVA revealed no significant main effect of gender [F(2, 16) =

0.801, p > 0.05], no significant main effect of learning group [F(1, 16) = 0.467, p > 0.05],
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and no significant interaction [F(1, 16) = 0.467, p > 0.05]. Data is summarized in Table

3.11.

Gender ldentity

Learning Group Female Male Non-binary Row Means
Traditional 5.250 5.000 Not Observed | 5.125

VR 6.000 5.000 5.000 5.333
Column Means | 5.625 5.000 5.000

Table 3.11. Enjoyment Levels in Stereoisomer Relationships by Gender and Learning
Group. Statistically significant differences in mean are noted with *, a = 0.05.

Factorial ANOVA also revealed no significant difference in the improvement of

comfort levels after this topic of the tutorial for students of different genders

experiencing either tutorial mode. The 2x3 ANOVA revealed no significant main effect of

gender [F(2, 16) = 0.278, p > 0.05], no significant main effect of learning group [F(1, 16)

=1.192, p > 0.05], and no significant interaction [F(1, 16) = 0.038, p > 0.05]. Data is

summarized in Table 3.12.

Gender ldentity

Learning Group Female Male Non-binary Row Means
Traditional 1.250 1.000 Not Observed | 1.125

VR 1.714 1.667 1.000 1.460
Column Means | 1.482 1.333 1.000

Table 3.12. Average Comfort Improvement in Stereocisomer Relationships by Gender
and Learning Group. Statistically significant differences in mean are noted with *, a =

0.05.

We concluded that the ethnicity or gender of the student seems to not have an

effect on how much the students enjoy VR or traditional learning nor does ethnicity or

gender have an effect on how much more comfortable students feel about the content

after VR or traditional instruction for this topic of the tutorial.
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Content Performance

Like from the Diels-Alder data collection, we kept records of content performance
with the check for understanding questions and the on-paper exam simulation. Check
for understanding question 1 (Figure 3.1) had an overall correct response rate of 0.333
(7/21), the VR learning group had a correct response rate of 0.364 (4/11), and the

traditional learning group had a correct response rate of 0.300 (3/10).

Q1. Determine the relationship between the following pair of molecules (circle one)

Enantiomers Diastereomers Constitutional isomers Identical molecules

Figure 3.1. Multiple-Choice Check for Understanding Question 1 for R/S Configurations
and Stereochemistry. Enantiomers is the correct answer.
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Check for understanding question 2 (Figure 3.2) had an overall correct response
rate of 0.571 (12/21), the VR learning group had a correct response rate of 0.636 (7/11),

and the traditional learning group had a correct response rate of 0.500 (5/10).

Q2. Determine the relationship between the following pair of molecules (circle one)

Br

OH

Clrawy

Enantiomers Diastereomers Constitutional isomers Identical molecules

Figure 3.2. Multiple-Choice Check for Understanding Question 2 for R/S Configurations
and Stereochemistry. Diastereomers is the correct answer.
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The on-paper exam simulation (Figure 3.3) had an overall correct response rate

of 0.190 (4/21), the VR learning group had a correct response rate of 0.182 (2/11), and

the traditional learning group had a correct response rate of 0.200 (2/10). We were

unable to conclude if there were any differences in learning outcome between the

students of different learning groups.

On Paper Exam Simulation
Determine the relationship between the following pair of molecules (circle one)

Enantiomers

Diastereomers

Constitutional isomers

|dentical molecules

Figure 3.3. Multiple-Choice Check for On-Paper Exam Simulation for R/S
Configurations and Stereochemistry. Identical molecules is the correct answer.

Data on content performance for R/S Configurations and Stereoisomers is summarized

in Table 3.13.
Overall VR Traditional
Question 1 0.333 0.364 0.300
Question 2 0.571 0.636 0.500
Exam Simulation 0.190 0.182 0.200

Table 3.13. Correct Response Rates for Content Performance in R/S Configurations

and Stereoisomers.
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3.5 Possible Sources of Error for R/S Configurations and Stereoisomers Tutorial
Although data collection was conducted at a more optimal timeframe, before
students were formally tested on determining configuration of chirality centers and
determining relationships of molecules, we suspect that the check for understanding
guestions were too difficult to accurately assess if students understood the presented
material. It is possible that student performances on the check for understanding
guestions did not have a statistically significant difference between the VR learning
group and traditional learning group because the problems were too difficult even for
students who had a good understanding of the content. Based on the correct response
rates of 0.33, 0.57, and 0.19 on the three questions with four choices available, we can
reasonably infer that the questions were too difficult. It is also possible that our data is
underestimating how comfortable students felt about the topics in the tutorials because
the post-survey was designed on one page, so the questions asking about comfort
levels on the topic after the tutorial were presented on the same page as the
challenging check for understanding questions. If some students felt discouraged after
answering the questions, they could have changed their responses to the comfort level
guestions, which could have resulted in a decreased average score than what we

expected after the tutorials.
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Chapter 4 Conclusion and Future Outlook
4.1 Conclusion

Although we were unable to conclude if VR learning in organic chemistry leads to
improved student performances on exam-like questions compared to traditional
learning, we saw that students in the VR learning group generally reported higher
enjoyment during the help session than students in the traditional learning group. From
the survey free response feedback, many students also showed excitement for the VR
tutorial and found the tutorials to be a “cool and enjoyable” experience. This indicates
that while VR learning cannot completely replace traditional learning in organic
chemistry education, it shows potential as a supplemental learning tool by increasing
student interest and engagement. We observed these trends in both the Diels-Alder
tutorial and the R/S Configurations and Stereoisomers tutorial, which we thought was
promising that VR can be helpful as a teaching supplement for both organic chemistry |
and Il topics. Our data also seems to suggest that the ethnicity or gender of the
students does not affect the efficacy of the VR tutorials, so VR may also be useful as an
equitable learning supplement. Considering that we had no prior knowledge in VR
development before this project but still obtained deliverable projects that resulted in
similar learning outcomes to traditional learning seems promising to future developers
who might be interested in developing supplemental VR tutorials to fit their class

material.
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4.2 Future Outlook on VR
Improvements for Developed Products

Due to limited time in development, there were some features in each tutorial that
we were unable to implement that could have further enhanced the learning experience
of the students.

In the Diels-Alder tutorial, we wanted to implement an undo reaction button, so
that students could redo the reactions multiple times to understand how the starting
materials combine to yield the reaction products. We also wanted to discuss the
regiochemistry of Diels-Alder reaction in addition to the stereochemistry to present a
more comprehensive tutorial. We also wanted to show the newly formed pi bond of the
products so that students could more easily visualize how part of the diene and the
dienophile came together to make the product. From the survey feedback, students also
requested to show more example questions and to cover more depth for topics like
electron orbital theory, requirements for the diene, and discussing electron withdrawing
and donating groups for regiochemistry. Students also suggested quality of life
improvements such as highlighting new bonds, making double bonds clearer, and
coloring the “outside” and “inside” substituents on the diene with different colors.

In the R/S Configurations and Stereoisomers tutorial, we wanted to highlight the
chirality center of the molecule in a different color to reduce confusion when students
are looking at the molecule. We also wanted to highlight specific atoms in a molecule for
discussing priority rankings to assign configuration of the chirality center. The ability to
highlight a given atom could have provided clearer information to the students. This was

unable to be implemented in time because Atomic Blender Utilities does not seem to
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allow selection of just one atom if there are multiple atoms of the same element, so
changing the color of one atom would change the color of every atom of the same
element. From the student feedback, we could make quality of life improvements to
make the flow charts and graphics less blurry, reminders to also look at the 2D drawings
after looking at the 3D models to facilitate the transition back to classroom learning, and
indicators for how many slides are left in the tutorial.
Possible Unexplored Topics for VR

Although we only have finished products for reinforcing reaction mechanisms and
3D visualization heavy topics, we also had instrument/lab equipment tutorials in mind as
possible topics for developing VR. Instruments and lab equipment used in organic
chemistry labs, such as the Gas Spectrometer or the rotational evaporator (“rotovap”),
can be daunting for first time users. Making a mistake when using an instrument while
working with toxic chemicals can be costly, and the instrument itself can also be costly
to repair or replace if damaged from the mistakes. We think that VR tutorials for such
lab equipment/instrument could help overcome the fear of using unfamiliar instruments
and equipment for first time organic chemistry lab students. Lab techniques that require
extensive set up such as distillation and reflux might also be appealing topics for a VR
tutorial. An easier method of developing a lab equipment/instrument tutorial could be the
VR developer carrying out the lab themselves, demonstrating how to properly handle
the equipment while filming a 360-degree video with a GoPro or similar equipment
attached to their forehead. The resulting footage can be incorporated into the VR
environment for the students to view the motions from a first-person perspective. For

such lab tutorials, the ultimate goal could be to have interactive lab apparatus simulation
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for every complex piece of equipment for the lab that students interact with. The
students would be able to manipulate and interact with the equipment in VR in any way
imaginable and the VR would have pre-programmed responses to give feedback to all
the creative choices a student could make in operating the virtual equipment,

maximizing the benefits of creative learning with VR.

4.3 Improvements on Methodology

There are a few improvements to the Diels-Alder and R/S Configurations and
Stereoisomers trials if there was more time for this project. More data points for analysis
would help in making a stronger conclusion, so recruiting more students or even running
the trials for another group of students could improve results. To account for the varying
difficulties of the questions in assessing content performance, giving students content
guestions before the tutorial to compare with their performance after the tutorial could
have helped in assessing if students in different learning groups improved their
understanding of the content. As an additional measure of efficiency of the different
types of tutorials, the time for completing the tutorials could also have been measured. It
would also be interesting to investigate if showing 2D drawings along with 3D models in
the VR tutorial affects learning outcomes for either the Diels-Alder tutorial or the R/S

Configurations and Stereoisomers tutorial.
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Appendix
Section A — StudentIRB Approval

This research collected data from students, so it is categorized as a human
subjects research, and requires approval from the Protection of Human Subjects
Committee (PHSC) or StudentIRB. Since this research was conducted in a commonly
accepted educational setting of optional help session and involved normal educational
practices that likely did not adversely impact students’ opportunity to learn, the research
was eligible for exempt research'®. Exempt research poses no more than minimal risk to
the participants, and the protocol for the research should be sent to StudentIRB for
review rather than to the PHSC?!. Items to submit with the protocol include: the
informed consent form for the participants detailing the purpose of the study, procedure,
possible risks and benefits, statement of confidentiality, statement of voluntary
participation, incentive for participation, and contact information of the investigators, the
list of survey questions for the participants, and relevant CITI training certificates for
every investigator.
Section B - Software and Hardware used for VR Development

The Meta Quest 2 headset was chosen as the VR headset and tutorials were
developed with the Unity game engine (version 2022.3.2f1). The VR environment and
functions were part of the Create-with-VR file under the Create with VR course available
on Unity Learn, adapted to suit the tutorials. 3D models of molecules were built with
Avogadro2 and Blender (Version 4.0). Unity Hub, Meta Quest Developer Hub, and the
Oculus PC app were installed, and a Quest Link Cable as well as a Meta Quest

developer account was acquired. Unity Hub, Oculus PC app, and the Quest Link Cable
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were used for developing and testing the VR with Unity, and the Meta Quest Developer
Hub and the Meta Quest developer account were used for distributing the finished
tutorials.
Section C —Importing 3D Molecules

To import the desired 3D molecules, we used Avogadro2, a software for editing
and visualizing chemicals'?. When building the molecules, we either drew the molecule
from scratch in Avogadro2, or we imported the molecule using the Simplified Molecular
Input Line Entry System (SMILES). Drawing the molecule from scratch works well with
smaller molecules, while using SMILES works well with larger molecules. One caveat
for importing molecules with SMILES is that have to check if the molecule imported with
the desired stereochemistry, as there does not seem to be a reliable way of importing
different stereoisomers or choosing the correct stereoisomer with SMILES, which often
led to editing the molecule after importing them. After importing the molecules, we
standardized the appearance of the molecules by Extensions -> Open Babel->
Optimize Geometry. After adjusting the molecule in Avogadro2, we exported the
molecule as a Protein Data Bank (.pdb) file by File -> Export -> Molecule and saving
as filename.pdb. Then we imported the saved file into Blender, a 3D computer graphics
software by selecting File -> Import -> Protein Data Bank (.pdb). We want to be sure
to select the Bonds checkbox under the Sticks/bonds menu to show any double or triple
bonds in the molecule. Select the desired molecule file and click Import Protein Data
Bank. To edit the molecules in Blender, we need an add-on, which we can obtain from
Edit-> Preferences and selecting Import-Export: Atomic Blender PDB/XYZ under the

Add-ons tab. Under the Import-Export: Atomic Blender PDB/XYZ dropdown menu,
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select PDB import/export and Utility panel. This creates a panel called Atomic
Blender Utilities under the Create tab on the right side of the Blender interface where
we can customize the atomic radii and bond sizes. Before exporting the molecule, we
can also orient the molecule according to the xyz coordinate directions, which will
become the local xyz coordinates for the molecule in Unity. To export the molecule, File
-> Export -> FBX (.fbx) and select Visible Objects under the Include dropdown. Select
Export FBX to save the molecule. Now these .fbx molecule files are available to be
uploaded into the Unity game engine as GameObijects.
Section D - Making 3D Molecules Interactable Objects

Drag the 3D molecule fbx file into the Hierarchy region of Unity, this makes the
3D molecule a GameObject that can be manipulated in Unity. The size of the 3D
molecule can be adjusted from the Inspector of the GameObject by assigning different
values in the Scale under Transform component. To the 3D molecule GameObject,
add the Rigidbody component, a Collider component (such as a Box Collider), and
the XR Grab Interactable component. In the Rigidbody component, change the
Collision Detection to Continuous Dynamic. For the XR Grab Interactable
component, change the Movement Type to Kinematic and nothing else has to be
modified if the orientation of the molecule does not matter when it is grabbed. If there is
a desired orientation when the molecule is grabbed, add an empty GameObject to the
3D molecule GameObject under the Hierarchy region by right clicking -> Create Empty
and orient the empty GameObject appropriately. Under the XR Grab Interactable
component, drag and drop the new empty GameObiject into Attach Transform. For the

Collider component, select the type of Collider that would best encompass the outline
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of the molecule, and edit the outline with the Edit Collider button and adjust the
outlines.
Section E - Making Reactions Between Molecules

To make reactions happen when molecules are in contact or in close proximity, a
hitbox is required. Under the Hierarchy region of Unity, create an empty GameObject to
the 3D molecule by right clicking -> Create Empty. In the Inspector of the empty
GameObiject, add a type of Collider component and check the Is Trigger box. Adjust
the collider size with the Edit Collider button and adjust the outlines. Also add the On
Trigger (Script) component and under On Enter (Collider), add all the actions that
should happen when the molecules make contact (e.g. the reactant molecules are set
as inactive, the product molecules are set as active, and the Continue button is set as
active).
Section F - Making and Linking Ul Panels

For the main panel, right click the Hierarchy region, XR -> Ul Canvas. Drag the
Main Camera (Camera) under Event Camera in the Inspector of the Ul Canvas. Set
the Order in Layer as 1. This main panel will serve like a projector screen for the other
panels. For the panels, right click the Hierarchy region, Ul -> Panel. These are like
individual slides on which we can put text, buttons, and images to design our VR
tutorial. For text, right click the panel, Ul -> Text - TextMeshPro and type the content in
the Inspector region under Text Input. For an image, right click the panel, Ul -> Image
and drag and drop the desired image to the Source Image under the Image component
in the Inspector region. Note that the image should be modified by going to the

Inspector of the image, going to Texture Type and selecting Sprite (2D and Ul). To
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make a button, right click the panel, Ul -> Button - TextMeshPro. The button has a
built in Text object that can be modified, and actions for when the button is clicked can
be set in the Inspector region, by adding actions to On Click (), where actions such as
setting the current panel as inactive, setting the next panel as active, and making
certain buttons active can be set up to employ adaptive release.
Section G - Uploading to the Headset

To upload and test on a Meta Quest 2 headset that has enabled developer
mode, the VR headset can be tethered to the computer with the Quest Link Cable and
Oculus PC app. Disabling the XR Device Simulator and clicking Play in Unity projects
the VR environment to the headset for quick testing and modifying of the simulation in
development. To test the product without being tethered to the computer, the simulation
must be built into the headset. While the VR headset is connected to the computer, go
to File -> Build Settings. Select Android under Platform and select the VR headset
under Run Device. Click Build and save the product as a .apk file on the computer.
When the build is finished, the product should be available in the VR headset when
navigating to Apps and under Unknown Sources from the dropdown menu.
Section H - Making the App Available for Other Headsets

To make the product available for other headsets that does not have developer
mode, the product has to be made into an application. Publishing an application on the
official VR app store is very lengthy and rigorous, another method had to be used to fit
the timescale of this project. Meta Quest has a secondary app store called App Lab for
distributing apps in development by a distribution link. First, log into the Oculus

Developer Dashboard with the developer account, click Create New App and select
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Meta Quest (App Lab). To build the .apk file, go to File -> Build Settings and go to
Player Settings. Go to the Publishing Settings dropdown menu and set up a Keystore
with the Keystore Manager. The Keystore serves like a password for making any
changes to the app. Under the Other Settings dropdown menu, go to Install Location
and select Automatic. Also note that every time the product is built as an .apk file for
upload, the Bundle Version Code should be different. Increasing the Bundle Version
Code by 1 each time a file is built seems to work. Build the .apk file. Navigate to the
Meta Quest Developer Hub and click App Distribution and the app name. Under the
alpha channel, upload the .apk file. Once the build is uploaded, the distribution link can
be found on the Oculus Developer Dashboard, go to Distribution -> Release
Channels and click on the alpha channel then go to Channel Settings. There should
be a Channel Invite and an option to Grant access to users by URL. When the users
click on the distribution link, they should log into their Meta accounts and accept the
invite, then they should be able to download the product to their Meta Quest 2 headsets

by searching the exact app name on the Quest store.
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Section | - Ul Panels for the Diels-Alder Tutorial

Welcg, = -

~-Ome tg the —
this exercige, DIEIS‘A'defTutorialr In
e

+ We wil) EXPlore th

Figure I.1. Aerial View of the Diels-Alder Tutorial.

Welcome to the Diels-Alder Tutorial! In
this exercise, we will explore the
simplest case Diels-Alder reaction and
the stereo and regiochemistry of the
reaction.

Cogd

Figure 1.2. Welcome Slide and Overview for Diels-Alder Tutorial
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Let's investigate the simplest Diels-
Alder reaction: a diene and an
dienophile. Bring the dienophile below
the diene to make the product.
Observe the double bond that is
formed.

Figure 1.3. Simplest Case Diels-Alder with no Substituents on the Diene or the
Dienophile

We broke 3 pi bonds and formed 2
sigma bonds and 1 pi bond. This
pattern will be consistent for every
Diels-Alder reaction.

Figure 1.4. Overview of the Reaction Mechanism with the Simplest Case Diels-Alder
Reaction
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The first requirement for Diels-Alder is
that the diene must be in the s-cis
configuration, that is, the double bonds
should be on the same side of the
single bond.

S-trans

- -
o= . = -8

Figure 1.5. First Requirement for the Diene to be s-cis for Diels-Alder

The second requirement for Diels-
Alder is the diene being conjugated, so
there should be exactly one single
bond separating the double bonds.

Figure 1.6. Second Requirement for the Diene to be Conjugated
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Even if we add substituents to the
diene and/or the dienophile, we still
follow the pattern for forming and
breaking bonds.

Figure 1.7. Introduction to Substituents on the Diene and/or the Dienophile

Bring the substituted dienophile under
the substituted diene to make the
product. (We will address
stereochemistry later)

Figure 1.8. Example of a Reaction of Substituted Diene and Substituted Dienophile
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If our diene or dienophile are cyclic, we
will make bicyclic Diels-Alder products.
Bring the dienophile under the cyclic
DIENE to make the bicyclic product.

Figure 1.9. Introduction to Bicyclic Products Resulting from a Cyclic Diene

Take note of how the bicyclic product is drawn on
paper. The product can be drawn in 2D (left) or in
3D (right). Compare the product molecule to the
drawings.

5

3 45
- D
-
"

@ 9

Figure 1.10. 2D and 3D Views of the Bicyclic Product from Figure 1.9.
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What if our DIENOPHILE is cyclic?
Bring the cyclic DIENOPHILE under
the diene to make the bicyclic product.

Figure 1.11. Bicyclic Products Resulting from a Cyclic Dienophile

The 2D representation of the product is shown.
Stereochemistry is omitted from the left figure.
Compare the product molecule to the drawings.

Figure 1.12. 2D and 3D Views of the Bicyclic Product from Figure 1.11.
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Let's observe the difference in products
when substituents on the DIENOPHILE are
cis or trans. Make sure to investigate both
cases before continuing.

Substituents on Substitudents on
the dienophile are the dienophile are
cis trans

Figure 1.13. Stereochemistry Resulting from the Dienophile being cis- or trans-.

If substituents are cis on the
DIENOPHILE, they should be syn on
the product.

Figure 1.14. Cis- Substituents on Dienophiles Result Syn- on the Product. This panel
shows when “Substituents on the dienophile are cis” is selected from Figure 1.13.
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If substituents are trans on the
DIENOPHILE, they should be anti on
the product.

Figure 1.15. Trans- Substituents on Dienophiles Result Anti- on the Product. This panel
shows when “Substituents on the dienophile are trans” is selected from Figure 1.13.

Let's try with an example reaction:

We will add the cis and trans isomers of a
dicarboxylic acid to the same diene and
observe the difference. Make sure to
investigate both cases before continuing.

Add the cis- Add the trans-
dicarboxylic acid dicarboxylic acid
to the diene to the diene

Figure 1.16. Example for Stereochemistry Resulting from the Dienophile being cis- or
trans-.
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Since the carboxylic acid groups are cis on the
DIENOPHILE, they are syn on the product.
Compare the product molecule to the drawing.

Figure 1.17. Example for Stereochemistry Resulting from the Dienophile being cis-. This
panel shows when “Add the cis-dicarboxylic acid to the diene” is selected from Figure
1.16.

Since the carboxylic acid groups are trans on the
DIENOPHILE, they are anti on the product.
Compare the product molecule to the drawing.

Figure 1.18. Example for Stereochemistry Resulting from the Dienophile being trans-.
This panel shows when “Add the trans-dicarboxylic acid to the diene” is selected from
Figure 1.16.



Let's observe the difference in products
when substituents on the DIENE are
"outside (labeled A)" or "inside (labeled B)".

”

Figure 1.19. Stereochemistry from the Diene Substituents being “outside” or “inside”.

Let's try with an example reaction:

We will add stereocisomeric DIENES where
one has both methyl groups on the "outside"
and the other has one methyl "outside" and
one "inside" to the same dienophile. Make
sure to investigate both cases before
continuing.

Both methyls One methyl "outside"
"outside" one methyl "inside"
Back Continue

Figure 1.20. Example for Stereochemistry from Diene Substituents being “outside” or
“‘inside”.
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Both methyls on the "outside" ends up on
the same side of the ring in the product. Both
hydrogens on the “inside" also ends up on
the same side of the ring. Compare the
product molecule to the drawing.

Figure 1.21. Example for Stereochemistry from Diene Substituents being “outside”. This
panel shows when “Both methyls “outside™ is selected from Figure 1.20.

One set of methyl and hydrogen on the
“outside” (labeled red) end up on the same
side, the other set on the “inside (labeled
blue) also end up on the same side.
Compare the product molecule to the
drawing.

Figure 1.22. Example for Stereochemistry from Diene Substituents being “outside” and
“‘inside”. This panel shows when “One methyl “outside” one methyl “inside™ is selected
from Figure 1.20.
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What if our diene and dienophile are
BOTH substituted?

We would create two products that are
diastereomers, an endo (major)
product and an exo (minor) product.
Let's investigate an example on the
next page.

Figure 1.23. Intro to Stereochemistry from Both the Diene and Dienophile being
Substituted.

Once you combine the reactants, we create an endo
product on the left and an exo product on the right.

Figure 1.24. Introduction to Endo- and Exo- Products.
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The endo product has the "outside” methyl groups
of the diene syn to the electron withdrawing
carboxylic acid groups on the dienophile. Inspect the
product molecule and notice how the substituents
from the diene and dienophile are on the same face
of the ring.

CHy ©

1
2 . OH
- OH
il

CH,
"Endo” diastersomer

Figure 1.25. Description and Example of an Endo- Product.

The exo product has the "outside" methyl
groups of the diene anti to the electron
withdrawing carboxylic acid groups on the
dienophile. Inspect the product molecule
and notice how the substituents from the
diene and dienophile are on different faces
of the ring.

P 5 e,
CH, o

"Exo" diastereomer

Figure 1.26. Description and Example of an Exo- Product.
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Let's investigate a second example on
the next page, where we will observe
endo and exo bicyclic products.

Figure 1.27. Introduction to Bicyclic Endo- and Exo- Products.

Once you combine the reactants, we create
an endo product on the left and an exo
product on the right.

Figure 1.28. Examples of Bicyclic Endo- and Exo- Products.
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The endo product has the "outside® hydrogen
groups of the diene syn to the electron withdrawing
carbonyl groups on the dienophile. Top view (left)
and side view (right) of the product is provided.
Compare the product molecule to the drawings.

Figure 1.29. Example of a Bicyclic Endo- Product.

The exo product has the “outside" hydrogen groups
of the diene anti to the electron withdrawing
carbonyl groups on the dienophile. Top view (left)
and side view (right) of the product is provided.
Compare the product molecule to the drawings.

Figure 1.30. Example of a Bicyclic Exo- Product.
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Congratulations! You have reached the
end of the Diels-Alder tutorial!

You may now take off your VR
headset.

Figure 1.31. Final Slide of Diels-Alder Tutorial.
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Section J - Ul Panels for the R/S Configurations and Stereochemistry Tutorial

Welcome to the Stereochemistry Tutorial! In this
exercise, we will explore determining R/S for chirality
centers and identifying relationships between
stereoisomers.

Throughout the tutorial, make sure to interact with the 3D
models of molecules to enhance your understanding!

Before we begin, make sure to locate the periodic table

on your left and the color keys for atoms on the models
on your right.

Continue

Figure J.1. Front Ul Panel of the R/S Configurations and Stereochemistry Tutorial.

KN 7RUS 05 WET 7 WB B G4 B e
Fe Co NI Cu 2Zn Ga
G G Nl

. e o
R R e S e i

S 33 W bl t0 I aLGM @7 T gsavER U 03 anioud (6 MG A IOHA aF BI04 MNS zp MR 31 AN 2

Sro| Y | Zr! Nbi Mo Ru'l‘l_h‘ A“!‘Ed;s__n
3 A DN e TR I ey S e P AL

w o oa xon m

s M Ty e TSI Te M 07 S T OIRA M

Figure J.2. Supplemental Periodic Table.
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Hydrogen (H)

Chlorine (CI)
Deuterium (D)

Bromine (Br)
Carbon (C)

Nitrogen (N)

Figure J.3. Supplemental Atom Color Chart.
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[ mistry Tutorial.
4. Aerial View of the R/S Configurations and Stereoche ry
Figure J.4.



These models are enantiomers of |buprofen. While
these two molecules have the same chemical
composition and connectivities, they have atoms
with different spatial arrangements that affect their
biological activity. (Only the S enantiomer is
biologically active!) Take some time to interact with
the 3D models!

NV
’ » . \
%

Figure J.5. Introduction to the Relevance of Chirality Centers.

It is often the case that only one enantiomer
of a molecule is biologically active, so we
would like to distinguish them.

By the end of this tutorial, we will be able to
determine R/S of chirality centers as well as
determine the relationships between

stereocisomers.

Figure J.6. Introduction to the Relevance of Chirality Centers Continued.




In organic chemistry |, chirality centers
are usually CARBONS that have
attachments to four different groups.

What does it mean for groups to be
different?

\

Figure J.7. Introduction to Chirality Centers in Organic Chemistry I.

When the four groups attached to a
carbon have different chemical
compositions, it is easy to see that the
carbon is a chirality center.

Figure J.8. Identifying Chirality Centers when Groups have Different Chemical
Compositions.




If the groups are not identical in
chemical compaosition or branching, the
groups will be considered different.
Click and see the example to move on.

See
Example

Figure J.9. Identifying Chirality Centers when Groups have Different Branching.

This molecule has two groups with the
same chemical composition of C3H7,
but since the groups have different
connectivities (different branching), this
molecule has a chirality center.

Figure J.10. Example of Groups with Different Branching. This panel shows when “See
Example” is selected from Figure J.9.




If the groups are not identical in
chemical compaosition or branching, the
groups will be considered different.
Click and see the example to move on.

See
Example

Figure J.11. Identify Chirality Centers when Groups have Different Branching with
Continue. The “Continue” button appears after students have viewed Figure J.10.

Here is an example of a carbon that is not a
chirality center (achiral). Notice how there
are two groups (methyls) that are exactly the
same in chemical composition and
branching.

Note that we cannot assign a configuration
(R or S) to this carbon because it is achiral.

Figure J.12. Example of an Achiral Center.




Let's practice identifying if a molecule
has a chirality center. Does the
provided 3D molecule have a chirality
center?

Figure J.13. Identifying Chirality Centers Practice 1.

Remember that for a carbon to be a chirality
center, there must be 4 different groups
attached to the carbon. Reconsider if there
are any groups that are identical to each
other.

Figure J.14. Identifying Chirality Centers Practice 1 Feedback for Yes. This is the
incorrect answer. This panel shows when “Yes” is selected from Figure J.13.




Correct! Since we have two nitrile
groups (C triple bonded to N) on the
central carbon, the carbon is not a
chirality center.

Figure J.15. Identifying Chirality Centers Practice 1 Feedback for No. This is the correct
answer. This panel shows when “No” is selected from Figure J.13.

Let's try another one. Does this 3D
molecule have a chirality center?

Figure J.16. Identifying Chirality Centers Practice 2.
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Correct! Although tert-butyl, isobutyl,
and sec-butyl all have the same
chemical composition, their
connectivities are different, so there
are 4 different groups on the central
carbon.

Br

4--|||II|SEC'bUWl

isobutyl Continue

Figure J.17. Identifying Chirality Centers Practice 2 Feedback for Yes. This is the
correct answer. This panel shows when “Yes” is selected from Figure J.16.

Remember that even if the groups have the
same chemical compositions, they are
considered different groups if their
connectivities are different.

Br

anilisec-butyl

tert-butyl
isobutyl

Figure J.18. Identifying Chirality Centers Practice 2 Feedback for No. This is the
incorrect answer. This panel shows when “No” is selected from Figure J.16.



For each chirality center identified, we
have to assign configurations (R or S)
to give a complete description of the
molecule.

We will discuss the steps of
determining R/S of chirality centers in

the following slides.

Figure J.19. Introduction to R/S Assignment.

The first step to determining R/S Is to
assign priority rankings to each of the
four groups attached to the carbon.
Assign 1 to the highest priority group,
and assign 4 to the lowest priority

group.

Figure J.20. Introduction to Ranking Priority to Groups.




Identify the atoms directly attached to the carbon,
give priority to groups that are connected to atoms
with the higher atomic humber.

Here's an example: Br is group 1 (highest priority),
OH is group 2, NH2 is group 3, and H is group 4
(lowest priority).

@Br
©

ulllllH

NH,
G

Figure J.21. Priority Ranking Based on Atomic Numbers.

If isotopes are present, the isotope with the
higher atomic mass receives higher priority.
In this example, D (deuterium) is an isotope
with a higher atomic mass than H, so Bris
group 1, OH is group 2, D is group 3, and H
is group 4.

J

Figure J.22. Priority Ranking Based on Isotopes.




If the priority can't be assigned using
the atoms bonded to the chirality
center due to a tie, use the next set of
atoms. Assign priority at the first point
of difference. Let's look at an example
of this in the following slide.

|

Figure J.23. Priority Ranking with Point of First Difference.

In this example, there is a propyl and
an isopropyl group. Both group's first
atom of attachments are carbons. In
case of such ties, list the next set of
atoms from highest to lowest atomic
number, then compare until there is a

difference.

A
o guaTe
6 "
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Figure J.24. Priority Ranking with Point of First Difference Example.




For the propyl group, the first carbon attached to the
chirality center is connected to C,H,H (labeled green).
For the isopropyl group, the first carbon attached to the
chirality center is connected to C,C,H (labeled purple).
Comparing the list of atoms starting from the left, the
isopropyl has higher priority than the propyl because C
has a higher atomic number than H.

Br

nnilisopropyl
HoN

Figure J.25. Priority Ranking with Point of First Difference Example Continued.

If an atom is doubly bonded to another
atom, treat it as if it were singly bonded
to 2 of those atoms.

If an atom is triply bonded to another
atom, treat it as if it were singly bonded
to 3 of those atoms.

Let's see an example of this in the

following slide.

I

Figure J.26. Priority Ranking with Double and Triple Bonds.




In this example, the first carbon attached to the
chirality center on the wedged group is connected to
C.C.H (labeled green). The first carbon attached to
the chirality center on the dashed group is
connected to C,C,C (labeled purple). Therefore, the
dashed branch has a higher priority than the
wedged branch.

Adoems
conmected o first

Figure J.27. Priority Ranking with Double and Triple Bonds Continued.

Let's practice assigning priority to
groups! Rank the following groups
from highest to lowest priority.

A IV, ILILL R B)IVILLILEC)I IV

Figure J.28. Priority Ranking Practice Multiple-Choice Question 1.

83
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Remember that if there is a triple bond, treat
it as If it were singly bonded to 3 of those
atoms. Then, list the connected atoms from
highest to lowest atomic number and look for
the first point of difference to assign priority.

Figure J.29. Priority Ranking Practice Multiple-Choice Question 1 Choice A. This is an
incorrect answer. This panel shows when “A) IV, lll, 11, I” is selected from Figure J.28.

Correct! Br has the highest atomic number,
followed by O. For |, carbon has attachments
to N,N,N. For Il, carbon has attachments to
N,H.H. Since N has a higher atomic number
than H, | has higher priority than II.

I i
— (\ NH,

I first atom of

subsliwent
] L_IJ 1

Figure J.30. Priority Ranking Practice Multiple-Choice Question 1 Choice B. This is the
correct answer. This panel shows when “B) IV, IlI, I, II” is selected from Figure J.28.
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Remember to rank the group directly attached to the
highest atomic number atom highest (It doesn't
maitter that | has a C with 3 N's, IV has a Br that
beats the C!) Also, look for the first point of
difference in the next set of atoms in case there are
ties for the first attached atom.

Figure J.31. Priority Ranking Practice Multiple-Choice Question 1 Choice C. This is an
incorrect answer. This panel shows when “C) I, IV, llI, 11’ is selected from Figure J.28.

Let's try another one! Rank the
following groups from highest to lowest

pnorlty

A) LT IV C) I, 1 1, 1V

Figure J.32. Priority Ranking Practice Multiple-Choice Question 2.
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Remember to rank the group directly
attached to the highest atomic number atom
highest, and look for the first point of
difference in the next set of atoms in case
there are ties for the first attached atom.

Figure J.33. Priority Ranking Practice Multiple-Choice Question 2 Choice A. This is an
incorrect answer. This panel shows when “A) IlI, 1, 1, IV” is selected from Figure J.32.

Remember if there is a double bond, treat it
as if it were singly bonded to 2 of those
atoms. Then, list the connected atoms from
highest to lowest atomic number and look for
the first point of difference to assign priority.

Figure J.34. Priority Ranking Practice Multiple-Choice Question 2 Choice B. This is an
incorrect answer. This panel shows when “B) I, I, lllI, IV” is selected from Figure J.32.
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Correct! Il has an O directly attached,
whereas the others have C attached. lll has
0,0,0 on the first carbon, | has O,0,H on
the carbon, and IV has H,H,H on the carbon.

Awams connorton
% first seom of
w0t

A0
\)

‘ l

Figure J.35. Priority Ranking Practice Multiple-Choice Question 2 Choice C. This is the
correct answer. This panel shows when “C) Il, Ill, I, IV” is selected from Figure J.32.

Once priority is assigned to the four
groups, orient the molecule so that the
lowest priority (group 4) is at the back,
so that it is pointing away from you.

Figure J.36. How to Properly Orient Molecules.



Once the lowest priority group is in the back,
draw a line through group 1, 2, then 3, in that
order. If the line is clockwise, the
configuration is R. If the line is
counterclockwise, the configuration is S.

Figure J.37. Assigning R or S.

Let us practice assigning R/S to
chirality centers. What is the
configuration (R or S) of the chirality
center of this molecule?

Figure J.38. Practice R/S Question 1.




Correct! Br is group 1, tert-butyl is group 2, sec-butyl
is group 3, and isobutyl is group 4. Once the isobutyl
group is at the back, the line through group 1, 2,
then 3 is clockwise. (Note that on paper, the line
looks counterclockwise because group 4 is not at
the back) Therefore, the configuration is R.

@Br

winsec-butyl

L. A
ern-ou
isobuty| @) Continue

Figure J.39. Practice R/S Question 1 Choice R. This is the correct answer. This panel
shows when “R” is selected from Figure J.38.

Check to see if the groups are correctly
ranked. Also check where the lowest
priority group should be when
designating R/S.

Br

Conisac-butyl

tert-butyl
isobuty)
Return

l

Figure J.40. Practice R/S Question 1 Choice S. This is the incorrect answer. This panel
shows when “S” is selected from Figure J.38.




Let's try another. What is the
configuration (R or S) of the chirality
center of this molecule?

Figure J.41. Practice R/S Question 2.

Check to see if the groups are correctly
ranked. Also check where the lowest
priority group should be when
designating R/S.

Figure J.42. Practice R/S Question 2 Choice R. This is the incorrect answer. This panel
shows when “R” is selected from Figure J.41.




Correct! Carboxylic acid is group 1, aldehyde is
group 2, Et is group 3, and H is group 4. Once H is
at the back, the line through group 1, 2, then 3 is
counterclockwise. (Note that on paper, the line looks
clockwise because group 4 is not at the back)
Therefore, the configuration is S.

Figure J.43. Practice R/S Question 2 Choice S. This is the correct answer. This panel
shows when “S” is selected from Figure J.41.

The molecules that we have been exploring so
far are called stereoisomers.

Isomers are different compounds with the same
molecular formula.

Stereoisomers are isomers that have the SAME
connectivities, but have different spatial
arrangement of atoms.

This is in contrast with constitutional isomers,
which are isomers with DIFFERENT

connectivities.

Figure J.44. Introduction to Stereoisomers.




We will explore three classifications of
stereoisomers in this tutorial:
enantiomers, diastereomers, and meso
compounds.

Figure J.45. Overview of Stereoisomers in this Tutorial.

We can determine the maximum
number of possible stereoisomers
based on the number of chirality
centers in the molecule. If a molecule
has n chiral centers, there are a
maximum of 2”n stereoisomers.

Figure J.46. Determining the Maximum Number of Stereoisomers.




For instance, this example molecule
has 2 chiral centers, so there are a
maximum of 272 = 4 stereoisomers.
We will further explore the different
classifications of stereoisomers with
these models.

l
] .

Figure J.47. Determining the Maximum Number of Stereoisomers Example.

Enantiomers are stereoisomers that
are mirror images of each other. An
example would be your hands - we can
easily see that our hands are mirror
images, but we can't stack them
exactly on top of each other.

I

Figure J.48. Introduction to Enantiomers.




Enantiomers are also called chiral
molecules, and they are optically
active. That is, they can rotate
polarized light. One enantiomer will
rotate polarized light to the right
(dextrorotatory), the other enantiomer
will rotate polarized light to the left

(levorotatory).

\

Figure J.49. Introduction of Enantiomers as Chiral Molecules.

Here is a selection of 2 stereoisomers out of 4 from
earlier. Determine the configuration of each chirality
center (two on each stereoisomer!) - which molecule
has the configuration of R, R?

Also verify with the provided 3D models that this pair
of stereoisomers are ENANTIOMERS (check that
they are non-superimposable, mirror images).

Left Right
Sterecisomer Stereoisomer
Back

R4

Figure J.50. Example of Enantiomers 1 with Question.




95

Correct! The configuration of both chirality
centers on the LEFT stereoisomer are R.
The configuration of both chirality centers on
the RIGHT stereoisomer are S.

Figure J.51. Example of Enantiomers 1 Question Choice Left. This is the correct
answer. This panel shows when “Left Stereoisomer” is selected from Figure J.50.

Reconsider your priority ranking of groups,
also remember to send the lowest priority
group to the back before assigning R or S.

Figure J.52. Example of Enantiomers 1 Question Choice Right. This is the incorrect
answer. This panel shows when “Right Stereoisomer” is selected from Figure J.50.



Shown below are the other 2
stereoisomers from earlier. Verify with
the provided 3D models that this pair of
stereoisomers are also
ENANTIOMERS (check that they are
non-superimposable, mirror images).

. s
-

Figure J.53. Example of Enantiomers 2.

Diastereomers are stereoisomers that
are non-mirror images of each other.

Figure J.54. Introduction to Diastereomers.




Here is a different selection of 2
stereocisomers out of 4 from earlier. Verify
with the provided 3D models that this pair of
stereoisomers are DIASTEREOMERS
(check that they are non-superimposable,
non-mirror images).

Figure J.55. Example of Diastereomers 1.

Here is another different selection of 2
sterecisomers out of 4 from earlier. Verify
with the provided 3D models that this pair of
stereoisomers are also DIASTEREOMERS
(check that they are non-superimposable,
non-mirror images).

Note: There are actually two more pairs we
could've selected that would also be

diastereomers.

Figure J.56. Example of Diastereomers 2.
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To summarize, here Is a simple schematic of the relationship
between 4 stereoisomers of a compound with 2 chirality
centers (and has no symmetry).

H2 Ne 49 d

A
\ i Qmtcae '.:’ N
& | b
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Figure J.57. Relationship between the Four Stereoisomers.

Interestingly, the presence of chirality
centers does not necessarily mean the
overall molecule is chiral.

A meso compound is an achiral molecule
that contains chirality centers.

We will explore this concept with a slightly

different set of molecules as before in the

following slides.

Figure J.58. Introduction to Meso Compounds.



Here is a pair of stereoisomers. Verify
with the provided 3D models that this
pair of stereoisomers are
ENANTIOMERS (check that they are
non-superimposable, mirror images).

Figure J.59. Enantiomer Pair of Stereoisomers. One molecule is R,R and the other
molecule is S,S.

Now, the interesting case for this molecule:
the meso compound.

Verify with the provided 3D models that this
pair of molecules are actually the SAME
molecule (check that they are
superimposable, mirror images).

Figure J.60. Meso Compound Pair of Stereoisomers.
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Let's try a thought exercise.

What would be the relationship between one of the
molecules of the enantiomer pair and the meso
compound? Use the models and the flow chart!

Figure J.61. Relationship between Meso Compound and Enantiomer Pair.

The relationship between one of the
molecules of the enantiomer pair and the
meso compound is that they are
DIASTEREOMERS. Using the model, we
can see that the molecules are non-
superimposable, non-mirror images.

Figure J.62. Relationship between Meso Compound and Enantiomer Pair Continued.



So how do we spot these meso
compounds? We have to look for
symmetry within the molecule.

Figure J.63. How to ldentify Meso Compounds.

A type of symmetry is a plane of symmetry. If we
can draw an imaginary plane through a molecule so
there are two halves of the molecule that are mirror
images, we have a plane of symmetry. In the
example molecule, we can have a plane of
symmetry perpendicular to the C-C bond. If
necessary, remember that we can also rotate single
bonds to recognize a plane of symmetry.

|

Figure J.64. Introduction to Plane of Symmetry.
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Let's practice identifying relationships between
molecules! What is the relationship between these
two molecules?

] : Meso
Enantiomers |Diastereomers
- - Compounds

Figure J.65. Relationship Between Stereoisomers Question 1.

Remember that enantiomers are non-
superimposable mirror images. Use your
models to evaluate if they are mirror images.

Figure J.66. Relationship Between Stereoisomers Question 1 Choice Enantiomer. This
is an incorrect choice. This panel shows when “Enantiomers” is selected from Figure
J.65.
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Correct! These molecules are non-
superimposable, non-mirror images, so
they are diastereomers.

Figure J.67. Relationship Between Stereoisomers Question 1 Choice Diastereomer.
This is the correct choice. This panel shows when “Diastereomers” is selected from
Figure J.65.

Remember that if these molecules are meso
compounds, they would actually be
superimposable and mirror images. Is that
the case here?

Figure J.68. Relationship Between Stereoisomers Question 1 Choice Meso Compound.
This is an incorrect choice. This panel shows when “Meso Compounds” is selected from
Figure J.65.
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Let's try another! What is the relationship
between these two molecules?

: . Meso
Enantiomers |Diastereomers
- Compounds

Figure J.69. Relationship Between Stereoisomers Question 2.

Remember that enantiomers are non-
superimposable mirror images. Use your
models to evaluate if they are mirror images.

Figure J.70. Relationship Between Stereoisomers Question 2 Choice Enantiomer. This
is an incorrect choice. This panel shows when “Enantiomers” is selected from Figure
J.69.
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Remember that diastereomers are non-
superimposable, non-mirror images. Use
your models to evaluate if they are
superimposable or mirror images.

Figure J.71. Relationship Between Stereoisomers Question 2 Choice Diastereomer.
This is an incorrect choice. This panel shows when “Diastereomers” is selected from
Figure J.69.

Correct! These molecules are actually the
same molecules when you rotate one of
them. We can also see that there is
symmetry in both molecules.

Figure J.72. Relationship Between Stereoisomers Question 2 Choice Meso Compound.
This is the correct choice. This panel shows when “Meso Compounds” is selected from
Figure J.69.
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Finally, what about these molecules? What
is the relationship between these two
molecules?

: . Meso
Enantiomers i reomer
Das‘e comersy compounds

| ‘ ; ~“c.‘ 3
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Figure J.73. Relationship Between Stereoisomers Question 3.

Correct! These are non-
superimposable, mirror images of each
other, so they are enantiomers.

M e “\]\h..

Figure J.74. Relationship Between Stereoisomers Question 3 Choice Enantiomer. This
is the correct choice. This panel shows when “Enantiomers” is selected from Figure
J.73.
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Remember that diastereomers are non-
superimposable, non-mirror images. Use
your models to evaluate if they are
superimposable or mirror images.

Me m]\h..

Figure J.75. Relationship Between Stereoisomers Question 3 Choice Diastereomer.
This is an incorrect choice. This panel shows when “Diastereomers” is selected from
Figure J.73.

Remember that if these molecules are meso
compounds, they would actually be
superimposable and mirror images. Is that
the case here?

Figure J.76. Relationship Between Stereoisomers Question 3 Choice Meso Compound.
This is an incorrect choice. This panel shows when “Meso Compounds” is selected from
Figure J.73.
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Congratulations! You have reached the
end of the Stereochemistry tutorial!

You may now take off your VR
headset.

Figure J.77. Final Slide of R/S Configurations and Stereoisomers Tutorial
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